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Nuove funzionalita e miglioramenti della versione 2023

Modellazione implicita

E stata aggiunta una nuova scheda, che include i seguenti strumenti e consente di modellare con geometria implicita. Invece di definire
esplicitamente la superficie o il contorno di un oggetto, la modellazione implicita rappresenta la geometria attraverso funzioni implicite,
definendo le relazioni tra i punti nello spazio mediante condizioni o vincoli. In questo modo & possibile modellare forme complesse,
irregolari e organiche estremamente leggere. E possibile manipolare e modificare in modo efficiente questa geometria versatile,
eseguire operazioni booleane e offset senza problemi e modellare in scala con una risoluzione elevata.
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Strumento Primitive
Consente di creare forme geometriche semplici che possono essere usate per attivita ripetitive o combinate in forme pit complesse. Le
primitive implicite includono cuboide, cilindro e sfera. Ogni tipo di primitiva prevede posizione, orientamento e dimensione controllabili.

Strumento Reticolo superficiale

Consente di riempire un corpo implicito con un reticolo superficiale, ovvero una struttura cellulare costruita da una o a volte due
superfici. Invece di affiancare o modellare una cella unitaria di base, la ripetizione naturale delle superfici crea automaticamente una
struttura reticolare. Esempi comuni sono le superfici minime triplamente periodiche (TPMS), come il giroide.
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Strumento Reticolo planare
Consente di riempire un corpo implicito con un reticolo planare, ovvero una struttura cellulare 2,5D con una sezione 2D chiaramente
definita, che viene estratta o estrusa lungo la terza dimensione. Un esempio comune € la struttura alveolare.

Strumento Reticolo con aste

Consente di riempire un corpo implicito con un reticolo con aste, realizzato da nodi collegati mediante aste. In genere, & presente una
cella unitaria di base che viene affiancata o modellata in una, due o tre dimensioni per formare la struttura reticolare completa. Un
esempio comune ¢ il reticolo cubico centrato sul corpo.

Strumento Nuvola punti
Consente di importare nuvole di punti o crearle da zero per determinare i campi o creare geometrie implicite.
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Strumento Campo
Consente di creare un campo per personalizzare un parametro implicito. E possibile costruire un campo da un'origine non ancora
descritta in un formato di campo e rimappare i valori di campo a intervalli diversi.

Un campo € una griglia 3D e ogni punto della griglia contiene un valore scalare con segno. Un esempio esplicativo consiste nella
creazione di un campo basato sulla distanza con segno da un piano o da una linea, per poi riscalare queste distanze in valori di
densita. Questo campo puo essere usato per controllare la densita relativa di un'altra geometria, come un reticolo, in ogni posizione
nello spazio.

Strumento Converti )
Consente di convertire parti in geometria implicita. E possibile selezionare parti CAD, PolyNURBS, mesh o parti ottimizzate. L'output &
in genere un campo di distanza con segno (SDF) per la geometria convertita.

Strumento Sposta corpi
Consente di traslare e ruotare corpi impliciti.

A ALTAIR © Altair Engineering, Inc. Tutti i diritti riservati. / altair.com / Nasdaq: ALTR / Contatti 3


http://altair.com/

Note sulla versione / Altair Inspire 2023 :! a LT a I R

Strumento Combina

Consente di combinare due corpi impliciti in uno. Viene creato un nuovo corpo contenente tutti i volumi che rientrano in almeno uno dei
corpi combinati. Equivale a una disgiunzione o a un OR logico.

ooV

Strumento Sottrai

Consente di sottrarre uno o piu corpi impliciti ("strumenti") da un altro corpo implicito ("obiettivo"). Viene creato un nuovo corpo implicito
contenente tutti i volumi che rientrano in tutti gli obiettivi ma non in tutti gli strumenti. Equivale a una negazione o a un NOT logico.

g

Strumento Interseca

Consente di mantenere solo le porzioni che si intersecano di due insiemi di corpi impliciti. Tutti gli obiettivi vengono combinati nel
"Corpo A" e tutti gli strumenti vengono combinati nel "Corpo B". Il risultato € un nuovo corpo implicito che contiene tutti i volumi presenti
sia nel Corpo A che nel Corpo B. Equivale a una congiunzione o a un AND logico.

v
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Strumento Offset

Consente di applicare un offset verso l'interno (negativo) o verso I'esterno (positivo) alla superficie di un corpo implicito. La superficie a
cui € applicato l'offset &€ normale alla superficie originale. L'offset pud essere espresso come valore costante, variabile o campo. Se si
attiva l'opzione Svuota, il modello viene svuotato e la regione tra la superficie originale e quella a cui € stato applicato l'offset viene
riempita di materiale.

yve

Strumento Inverti
Consente di invertire "interno" ed "esterno” di un corpo implicito invertendo il segno di tutti i valori scalari nel campo sottostante.

Un esempio esplicativo consiste nell'inversione del campo di una sfera. In questo caso, il risultato sara un cubo delle dimensioni del
volume d'ingombro che circonda la sfera, con un intaglio sferico al suo interno. La sfera che un tempo era solida & ora un vuoto, mentre
il vuoto esterno che circonda la sfera originale € ora solido.

Strumento Morphing
Consente di eseguire il morphing di un corpo implicito in un altro e viceversa. Corpi fisicamente separati potrebbero non produrre
risultati significativi.

Un esempio esplicativo consiste nell'overlay di un cubo (Corpo A) e di una sfera (Corpo B). Valore morphing, che deve essere
compreso tra 0 e 100, controlla un'interpolazione lineare tra i campi sottostanti dei Corpi A e B. Se Valore morphing ¢ pari a 0, si
ottiene una copia perfetta del cubo (Corpo A), mentre se Valore morphing & pari a 100, si ottiene una copia perfetta della sfera (Corpo
B). Se Valore morphing € 50, si ottiene un nuovo corpo implicito che presenta alcuni attributi sia della sfera che del cubo, ovvero un
cubo arrotondato.
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| parametri di morphing basati su campo possono generare geometria simile a un loft lungo la direzione del campo.

Strumento Smoothing
Consente di ridurre le dimensioni di elementi piccoli e affilati indesiderati in un corpo implicito o di rimuoverli.

Lo smoothing & analogo alla "sfocatura" nell'elaborazione delle immagini digitali. Prevede lo spostamento di una finestra attraverso il
campo sottostante, eseguendo operazioni di filtro sui valori del campo che rientrano nella finestra. | filtri di smoothing di esempio
includono Media, Mediana, Gaussiano e Laplaciano. Ognuno di questi filtri ha pro e contro relativi e offre effetti di smoothing diversi.
E possibile selezionare un secondo corpo implicito come maschera. In questo caso lo smoothing avverra solo all'interno del volume di
tale maschera.

Strumento Fillet
Consente di arrotondare gli spigoli dei corpi impliciti per creare fillet con raggio costante o variabile.

| fillet possono essere applicati separatamente agli spigoli convessi e concavi. A differenza del CAD tradizionale, I'effetto fillet verra
applicato a tutti gli spigoli qualificati presenti nel modello, anziché a quelli selezionati manualmente. | raggi possono essere valori
costanti, variabili o basati su campo.

A ALTAIR © Altair Engineering, Inc. Tutti i diritti riservati. / altair.com / Nasdaq: ALTR / Contatti 6


http://altair.com/

Note sulla versione / Altair Inspire 2023 :! a LT a I R

Rendering

Nuova tecnologia di rendering
e Tutta la tecnologia di rendering & stata aggiornata e sono disponibili due nuove modalita di rendering. Le nuove modalita di
rendering e le relative qualita distintive sono elencate di seguito:

e Prestazioni
e Motore di rendering interattivo basato sulla posizione fisica
e Rendering ad alta velocita
e Compatibile con tutte le GPU

e Qualita
e Motore di rendering interattivo basato sul ray tracing
e Rendering di altissima qualita con funzionalita complete di denoiser integrato

e Compatibile solo con GPU con core di ray tracing hardware disponibili
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Miglioramenti relativi a prestazioni e flusso di lavoro
e Semplificazione dell'interfaccia utente per il rendering per ottimizzare il flusso di lavoro

e Nuovi materiali basati su procedure per la creazione e la modifica intuitiva dei materiali
e Miglioramento delle prestazioni dell'applicazione per gestire modelli piu grandi e complessi

e Aggiunta del supporto per una gamma piu ampia di dati di simulazione

Pulsante di controllo aggiornamenti per l'importazione di asset

e  Gli asset per materiali e ambienti vengono ora archiviati online. Il nuovo pulsante di controllo aggiornamenti nella libreria del
motore di rendering consente di importare le risorse piu recenti nell'applicazione.

Render Library X

Check for Updates
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Fluids

Scambio termico coniugato

Fluids offre ora la possibilita di simulare lo scambio termico coniugato (CHT) in stato stazionario. Una simulazione CHT in stato
stazionario calcola il campo di temperatura di equilibrio finale all'interno di solidi e fluidi e consente il passaggio del calore tra fluidi e
solidi. Il calcolo dello scambio termico tra fluidi e solidi fornisce risultati pit accurati per la distribuzione della temperatura, i flussi di
calore e il comportamento termico complessivo all'interno della simulazione. Prevedendo le temperature di picco e medie dei
componenti solidi, le simulazioni CHT possono essere utili anche per identificare le aree sensibili dal punto di vista termico e a garantire
che i limiti termici del materiale non vengano violati.

Analysis Expiorer

Le simulazioni CHT in stato stazionario possono essere eseguite selezionando le opzioni Calcola problema termico e Includi solidi nella
finestra di dialogo Esegui analisi di Fluids.

Run Fluids Analysis  ©ioiiiifiiiizioininoniinin X
m Advanced
Mame: CHT_Demo|
Resalution
Show grid
Compute themmal problem
Include zolidz

Reset  + Run Close

Condizione al contorno faccia

La nuova opzione Condizione al contorno faccia consente di specificare le condizioni al contorno termiche sulla faccia di una parte
solida o fluida. Oltre alla condizione termica, & possibile specificare una condizione di velocita di scorrimento sulla faccia. Per
impostazione predefinita, tutte le superfici non specificate vengono considerate come pareti adiabatiche (isolate termicamente) senza
scorrimento.

® ©® QG .

Inlet Outlet Face Part

Conditions Run
Solids |~ Fuids | Ambient

Select a surface that is not an outlet or aninlet. 24 2
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Condizione alla parte
La nuova opzione per la condizione alla parte consente di specificare le fonti di calore nelle parti solide.

® ©® GaQ ¢

Inlet Outlet Face Part

Conditions Run

Select a solid part. then use the microdialog to define the constant heat source.

Heat source: | Total Power v 400w

Domini solidi mobili

E ora possibile designare le parti di un'analisi di Fluids come solidi movibili usando il nuovo strumento Dominio solido mobile. | solidi

movibili sono esclusi dal processo di identificazione del volume di fluido. Questa funzionalita semplifica il processo di estrazione del
volume di fluido e riduce le possibilita di errore.

Accelerazione della convergenza con il solutore lineare AMG (Algebraic Multigrid)

Fluids include ora un solutore lineare AMG. Abilitare AMG pud velocizzare la convergenza in alcuni scenari con percorsi dei fluidi lunghi
o quando si usano dimensioni voxel molto ridotte. Per attivare questa funzionalita, selezionare la casella di controllo Migliora
convergenza nella scheda Avanzate della finestra di dialogo Esegui analisi di Fluids.

Run Fluids Analysis  D:iiiiiiiiiniinoononiniinis X

Simulation | Advanced

Temination criteria: Physics or equations -

Output frequency steps: 500

Max. time steps 2000

Suface Monitar: Add Sufaces

Flow type: Turbulent »

Cument GPU: RTX AGDOD v
Validate GPL

Reset  « Run Close
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Simulazioni piu rapide

/\ ALTAIR

Le simulazioni in Fluids sono ora fino a due volte piu veloci rispetto alla versione 2022.3, grazie ad algoritmi piu efficienti.

Velocizzazione del solutore

Static Mixer Exhaust Manifold
m2022.3 m2023 m2023-AMG

Fluids disponibile per Linux

Inspire Fluids & ora disponibile per i seguenti sistemi operativi Linux:
e  SUSE Linux Enterprise Server 15 SP3
e Red Hat Enterprise Linux 8.4/Oracle Linux 8.4 o successiva

Semplificazioni locali e forme circolari

E ora possibile aggiungere semplificazioni locali a un modello di Fluids dopo aver eseguito un'analisi. E possibile scegliere di creare
semplificazioni in forma lineare o circolare e usare la microfinestra per organizzare e spostare la nuova regione di semplificazione. E
inoltre possibile disattivare le semplificazioni degli ingressi predefinite.

@5l B kA S
2 [ inlet Seeds %
: Mame Dimension N Points

i [Cweuds 1 | [0:008m 2 B A

: Lne1 0.018m 0 [ A
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Geometria

Strumento Ritaglia/Dividi migliorato

I nome dello strumento Proietta e dividi & stato modificato in Ritaglia/Dividi. Usare questo strumento migliorato per rimuovere parte di
una superficie o di un solido proiettandovi una curva profilo. In alternativa, usare un insieme di superfici strumento per dividere un
insieme di superfici obiettivo.

Strumento Nervatura

Il nuovo strumento Nervatura costituisce una soluzione pratica per consentire a progettisti e ingegneri di aggiungere ai modelli elementi
a parete sottile che migliorano la resistenza e l'integrita strutturale del progetto. Lo strumento consente di specificare la posizione, le
dimensioni, la forma e altre proprieta della nervatura. Questi elementi possono anche essere parametrizzati per usarli in una tabella di
progettazione.

Strumento Curva NURBS migliorato
E ora possibile creare una curva NURBS nello spazio 3D facendo clic nella finestra di modellazione, in modo simile a Curva raccordo.

Strumento Estendi superficie
Usare il nuovo strumento Estendi superficie per estendere una superficie lungo uno o piu spigoli. E possibile estendere la superficie
fino a una curva o a un'altra superficie.
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Strumento Curve di offset
Usare il nuovo strumento Curve di offset per creare una copia di una o piu curve a una distanza specifica dalla curva di origine. Questo
strumento puo essere usato sia per curve 2D che per quelle 3D.

Strumento Interseca curve
Usare il nuovo strumento Interseca curve per dividere curve o corpi reticolo che si intersecano in piu curve, con la possibilita di
combinarle in un'unica curva.

Strumento Loft migliorato

Nella microfinestra & stata aggiunta una nuova opzione di vincolo Vettore tangente libera. Selezionando questa opzione, la superficie
del loft viene resa tangente a un vettore selezionato. E possibile manipolare sia la grandezza che la direzione del vettore selezionato.
Se si selezionano piu vettori, le modifiche vengono applicate a tutti.

Lo strumento Loft prova ora ad abbinare il numero di vertici tra i profili in base al profilo con il numero massimo di vertici.
Quando il profilo &€ una curva periodica, € possibile selezionare la giunzione e trascinare lungo la curva.

Ora € possibile selezionare il profilo stesso, non solo i vertici del profilo, per accedere alle opzioni della microfinestra.

Strumento Sweep multiplo migliorato
Quando il profilo &€ una curva periodica, € possibile selezionare la giunzione e trascinare lungo la curva.

Ora ¢ possibile selezionare il profilo stesso, non solo i vertici del profilo, per accedere alle opzioni della microfinestra.

Strumento Estendi curva migliorato

Nel pannello guida & stata aggiunta una nuova opzione Crea nuova parte. Attivare questa opzione per rendere I'estensione una nuova
parte. E anche possibile selezionare lo spigolo di una superficie o di una faccia ed estenderlo come curva. L'estensione sara una nuova
curva.
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Struttura

Strumenti per report
Nella scheda Strutture sono stati aggiunti i nuovi strumenti Report rapido e Report. Tali strumenti sono disponibili in seguito a un'analisi
strutturale.

Usare lo strumento Report rapido per generare un report dell'analisi strutturale in base alle impostazioni salvate. E possibile esportarlo
come PPT o PDF. Il report include dati dei materiali, informazioni del modello, impostazioni di esecuzione, informazioni sulle condizioni
di carico, immagini e risultati. [l modello in formato PPT pud includere loghi.

Usare lo strumento Report per configurare le impostazioni e creare un report dell'analisi strutturale. E possibile salvare le impostazioni
per usare per i report rapidi. E possibile selezionare scene di viste salvate, pitl casi di carico e pil tipi di risultati da usare per le diverse
esecuzioni. E anche possibile salvare scene in un file .stmod con lo strumento Vista e usarle per acquisire viste delle aree sensibili del
modello per condizioni di carico specifiche.

File Edt View Sketch Geomety PolyMesh PolyNURBS Implict Stucwre Motion Fluids DesignExplorer Print3D Manufacture Developer

QL EFONET B DB DB

& &

Analyze  Optimze  Report

Files  Measue  Move Variables | Fasteners  Joints  Bushings Connectors SpotWelds Contacts loads  Disps  Accels  Materials Masses  Systems Shape Contiols Bead Pattems
Home Connections Setup Run
a N - . Analysis Explorer x
Roport Run 5
General ' Views | Results hanger_run (9) ]
Setiings File | Defautts &= FoadCasg 2
Load Case 1
hanger_run Result Types v
Tite Displacement B
Displacement: Mag v #
Max 4427e-03m
— 44276 03m =
et —3984e03m
Gk —3541e03m
—3099%-03m
—2656e03m
—2213e03m
Save A © PPT —1.771e03m
GEE —1328e03m
—8853e04m
—4427e04m
P— —6701e-10m

Restore ~ Save Setings || Create Min: 0.000¢+00 m
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Vincolo di ottimizzazione fresatura a 5 assi

Il vincolo di fresatura a 5 assi consente di ottenere risultati di ottimizzazione che emulano le capacita di una fresatrice a 5 assi, usando

due assi rotativi aggiuntivi (A e B) per un approccio multidirezionale dello strumento di taglio. Questo vincolo aggiunge un altro
processo produttivo ai risultati dell'ottimizzazione.

File Edit View Sketch Geometry PolyMesh PolyNURBS Structure Motion Fluids Design Explorer Manufacture Print3D Developer

Ve RIONET HEL S BB L DD a@

Joints  Bushings Connectors SpotWelds Contacts Loads

Disps  Accels  Materials Masses  Systems

Shape Controls Bead Patterns
Home

Analyze  Optimize
Connections

Setup

S S L

Single SpliDaw Radial Exirusion Overhang  Milling
Draw

Run

Select a design space. 2
Ctrl+ 8 Addjremove from selection

Del Delete milling,
F1 Show Help

Ricerca contatti SimSolid per solidi

E stato incorporato l'algoritmo di contatto SimSolid per velocizzare la ricerca dei contatti e supportare coppie di parti.

Vecchio

Nuovo
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Aggiunta del pretensionamento dei bulloni all'analisi SimSolid
SimSolid supporta ora il pretensionamento dei bulloni, consentendo di ottenere risultati piu precisi all'interno dei bulloni.

Propary Edror
Harre Wihee
A Gereral
Harre Fustoner 3
Muedal  Seel (AIS1 308

Nt sl Bolt

?Egg-

W gl
3 Pt

-]
000N
4

i

Famters 3

HAuial Foroe - 1.000e-00H

Shear Foroe - 2 100e+01 N

Bueeding Momens : 1 516e+01 Nmm =7~

Q@eTEEa D =ERI@B b

Mure ~ Tigd + Misfoes » Swefoos »  HendegMement «

Applicazione delle condizioni al contorno agli elementi della mesh
E ora possibile applicare le condizioni al contorno alle parti della mesh da modelli STL ed eseguire analisi in SimSolid. Vengono inoltre

calcolati i contatti per modelli mesh o misti CAD/mesh.

TagRo. 08 aa
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Applicazione di boccole ancorate a elementi in piu parti per OptiStruct
E ora possibile applicare boccole ancorate a elementi in piu parti per OptiStruct. Cid consente di creare le condizioni per piu

connessioni per i modelli OptiStruct.

A A

X | 353521363 e
b 65T em
Fid 00sm

PolyMesh

Strumenti Riempi e Converti rimossi
Gli strumenti Riempi e Converti sono stati rimossi in quanto le funzionalita di riempimento e conversione, migliorate e avanzate, sono

ora disponibili tramite la modellazione implicita.
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Produzione

Miglioramenti apportati all’analisi di porosita
e L'analisi di porosita ora supporta i file .stl.
e |l menu Materiali include ora l'intera libreria dei materiali, incluse le leghe.

Run Analysis iiiiiiiiiiiiiiiiiiin

MName: +10_degrees
Element Size:

(@ Aluminium  + A7075
Aluminium &

astiron h

Cobalt

Copper

Gold
Magnesium
Nickel

Silver v

e | risultati includono una gamma pit ampia di tipi di risultato.
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Analysis Explorer *:iiiiiil X

Run ¥
+10_degrees (1) v

Stage X
Solidification

Result Types ¥
Temperature v
Temperature

T 5olid Fraction
Solidification Time
j Microparosity
MNiyama
:Solidif. Modulus
Geo Modulus h.
Pipe Shrinkage
Paorosity
Total Shrinkage Wolume

TSI T UE TL
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Stampa 3D

Finestra Materiali
La finestra Materiali include ora una scheda per le proprieta della polvere, tra cui Conducibilita, Densita e Calore specifico.

Materials iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiniiiiiiiiiiniiniinoX
Materials Database - My Materials
Material Name Aluminum AISi10Mg ¥
General . Thermal - Mechanical © Powder
Density ¥
Conductivity
Density [
Specific Heat -
129315 13150
253315 12918
377315 12686
4 82315 12289
5 88565 1188.0
6 91065 11857
792315 11845
1320 -
1300 -
& 1280 -
E
5 1260 -
21240 -
2
& 1220
1200 -
1180 -
3;}0 4;}0 5;}0 6;}0 ?il}u 8;}0 9;}0
Temperature
Select Import Export Edit
Generale

Strumento Visualizza migliorato
Lo strumento Visualizza & stato migliorato e ora include lo stato di visualizzazione di tutti gli oggetti del modello, come parti, carichi,
fissaggi e sezioni.
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Piani delle sezioni
E ora possibile creare una sezione su una selezione di parti senza influire sulle altre. E possibile usare questa funzionalita insieme agli
strumenti Visualizza e Report per automatizzare i flussi di lavoro della documentazione.

Importazione di file .3mf
E ora possibile importare file .3mf in Inspire.
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Funzionalita di importazione migliorata per Gestione variabili

Durante l'importazione le variabili vengono unite a tutte quelle esistenti per impostazione predefinita. Per cancellare le variabili esistenti
durante l'importazione, nella finestra di dialogo Gestione variabili, selezionare Cancella variabili durante I'importazione nel menu
hamburger.

Design Explorer

Supporto per Linux
Design Explorer & ora supportato in Linux.

e  SUSE Linux Enterprise Server 15 SP3
e Red Hat Enterprise Linux 8.4/Oracle Linux 8.4 o successiva

Estrazione delle risposte non del solutore
E ora possibile eseguire un'esecuzione quando sono presenti solo risposte del modello e nessuna risposta del solutore.
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Movimento

Profili multi-segnale

Con questa nuova aggiunta ai tipi di ingresso nell'Editor profilo, & possibile creare profili di input complessi che includono piu segnali
nello stesso input. In precedenza, gli input erano limitati a singole funzioni, come Step, Step Sosta Step e sinusoidale, e per creare
espressioni complesse era necessario scrivere manualmente le espressioni del solutore. Ora € possibile creare tali espressioni in modo
semplice e veloce, usando un'interfaccia interattiva direttamente nell'Editor profilo.

(3T T/5[=:T i+ 7 BB0886000600606000006000000060860008800000060660060600000006066000000000000060000006000000000600000000000008 " £al
Function:  7_ + m Actuator 6 - Displacement
Signal: Va 00 1
Value: 13.0mm
Start Time: 02s| |Rel |+ =l Signal 2
Duration: 05s =T
Y = 20.687
Convert to Table
200 r
)
E
E 150
£
o
5
Signal Edit 100
1 Step -
2 Step v (] 50
3 Step -
00 —
0 05 1 15 2
Time (s)
End Time: 208 | # 1 2 5 0 30 60
Fit Orchestrate | Output Rate: 300 Hz 10 30 50 100 300 500

Nuova grafica per i giunti

| giunti non sono piu rappresentati solo come superfici evidenziate, ma ora rappresentano piu fedelmente il tipo di connessione fisica e i
relativi gradi di liberta. La nuova grafica dei giunti & identica a quella usata da Altair MotionView.

@& =m0 ?

Hinge Cylindrical Planar Translational Ball & Socket Unknown Contact

Selezionando la grafica di un giunto, viene visualizzato un manipolatore di dimensioni che consente di adattare le dimensioni visibili
dell'icona.
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Nuova opzione di creazione giunti
E ora possibile creare giunti selezionando una o pill parti singolarmente, quindi spostandosi gradualmente nel modello. In precedenza,

per ridurre i tempi di ricerca di elementi giunto, era necessario nascondere tutte le altre parti e mostrare solo quelle correlate al giunto.
Ora sulla barra guida sono disponibili due opzioni per la creazione di giunti: Tutte le parti e Seleziona parti.

Il funzionamento di Tutte le parti & identico a quello precedente, ma la funzione Trova non & pit automatica. E necessario fare clic sul
pulsante Trova per cercare il modello. Con Seleziona parti € ad esempio possibile selezionare due parti per visualizzare solo i candidati
agli elementi giunto tra queste due parti. Cid consente un approccio piu graduale alla creazione dei modelli. Inoltre, evita lunghi tempi di
ricerca di elementi giunto comuni.

= | APatsv | Fnd HE TR <[] A |» k| x

1
h all parts for fleatures. or use Select Parts to walk through the model.
1

Nuova opzione di modifica giunto

E ora possibile modificare la posizione e I'orientamento del giunto usando uno strumento di spostamento integrato disponibile nella
microfinestra del giunto. E disponibile anche I'opzione di ripristino. Il giunto pud essere modificato in qualsiasi tipo, indipendentemente
da quello creato da Inspire in base alla geometria rilevata.

: X [0az2z7ml
$Y [0a77m
: Z |015Im

Move
Translate or rotate using the Move tool.

Tabella elenco per i corpi flessibili

E ora disponibile una tabella per i corpi flessibili. La tabella mostra uno schema organizzato dei parametri associati ai corpi flessibili,
come Numero di modalita, Piu veloce/Piu accurato e altro ancora.

F=m=Ta 5535555555555055550505500a550005000000000055000505505055000500000500505500050050505500050000055000550005000500508000050005500053500505008 &
Name - Flexible Body Rexbody Element Order Normal Modes Frequency Type exbody Stress Calculatio Fexbody Strain Calculation
J,— Base
ﬁ Link Crank More accurate 15 Momal Modes Al None
47 Link Dual Slot Faster 10 MNormal Modes Al None
ﬁ Link Single Slat Faster 10 Momal Modes Al None
W Mount Clevis

u Mount Crank

Accesso a Cronologia esecuzioni

| dati di Cronologia esecuzioni possono ora essere tracciati senza caricare un modello usando una nuova icona satellite temporanea
che apre Gestione grafici. Dopo che un modello € stato caricato e risolto per la prima volta, l'icona viene sostituita da un segno di
spunta blu. Quando l'icona si trasforma in un segno di spunta blu, & possibile accedere a Cronologia esecuzioni solo da Gestione
grafici.

o Analyze Motion

Miglioramenti nella creazione di mesh di corpi flessibili
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Sono stati apportati miglioramenti significativi per evitare errori di creazione di corpi flessibili.

API Python

Generale

Sono state aggiunte nuove API per la memorizzazione e il richiamo di viste.

Geometria

Aggiunte funzionalita Nervatura: & ora possibile creare elementi a parete sottile dei modelli che migliorano la resistenza e
l'integrita strutturale del progetto.

Aggiunte funzionalita Estendi superficie: € ora possibile estendere la superficie fino a una curva o a un'altra superficie.
Aggiunte funzionalita Curve di offset: € ora possibile eseguire l'offset delle curve a una distanza specifica dalla curva di
origine.

Aggiunte funzionalita Interseca curve: € ora possibile dividere curve o corpi reticolo che si intersecano in piu curve, con la
possibilita di combinarle in un'unica curva.

Aggiunte funzionalita Estendi curva: € ora possibile estendere una curva 3D o un corpo reticolo.

Aggiunte funzionalita Curva raccordo: € ora possibile creare una curva a forma libera che si unisce in una o piu curve,
superfici o spigoli esistenti.

Aggiunte funzionalita Curva faccia: € ora possibile estrarre curve da una faccia nella direzione U o V.

Aggiunte funzionalita Ritaglia e Dividi: & ora possibile rimuovere parte di una superficie o di un solido proiettandovi una curva
profilo.

Modellazione implicita

Sono state aggiunte APl complete per la generazione e la modifica di componenti impliciti. E ora possibile modellare
rapidamente forme complicate, irregolari e organiche.

Strutture

Aggiunta di un'API per il vincolo di fresatura a 5 assi.
Sono state aggiunte le API per lo strumento Report. Ora € possibile usarlo per creare report personalizzati.
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Migli

oramenti

Aggiunta degli spostamenti forzati su un foro cilindrico [IN-31780]

Supporto API per lo strumento Estendi superficie [IN-31698]

Aggiunta di un'opzione di importazione della geometria per supportare correttamente i nomi dei punti [IN-30298]

Aggiunta della possibilita di aggiungere/rimuovere parti da Sezioni [IN-9456]

Aggiunta del supporto per le variabili agli strumenti Partizione [IN-31142], Fillet spigoli [IN-31140], Curva NURBS [IN-31139],
Curva elica [IN-31138], motivi di schizzo [IN-30905], Offset [IN-31144] e Semplifica geometria [IN-31141]

Possibilita di usare lo strumento Estrai per estrarre linee e punti da linee e punti di riferimento [IN-30709]

Possibilita di applicare controlli di forma Simmetria ed Estrusione nella stessa esecuzione di ottimizzazione [IN-30659]

Le boccole ancorate possono ora connettere piu facce cilindriche tramite piu parti [IN-30299]

Errori risolti

Inspire non esegue piu il checkout di 30 unita di licenza per attivare l'interfaccia utente di Print3D [IN-33014, IN-32940]
Corretto I'arresto anomalo di File Nuovo dopo l'isolamento della parte nel contesto di simulazione quando il modello contiene
misure [IN-33386]

Corretto un arresto anomalo durante I'apertura di un file contenente una parte PolyNURBS [IN-31381]

Corretto un arresto anomalo durante I'apertura di un file contenente dati danneggiati da un file della versione 2022.2 [IN-
33087]

Corretta una nota ignorata con elementi di secondo ordine [IN-32845]

Corretta la dicitura giapponese [IN-32392]

Corretto il mancato rilevamento del contatto dopo la lettura della geometria con errori di superficie [IN-32326]

Corretto un arresto anomalo durante il salvataggio di un file con un nome diverso [IN-32121]

Corretto lo spostamento del centro della vista del modello durante la rotazione [IN-31374]

Corretto ViewCube per la modalita Scuro [IN-30643]

Corrette le traslazioni di importazione file STEP [IN-31130]

Corretta la mancata applicazione delle forze perpendicolarmente alle facce [IN-31713]

Corrette le boccole ancorate per I'analisi modale [IN-30848]

Corretta la risposta assiale e il taglio del fissaggio [IN-29631]

Errori noti

Problemi di pre-evidenziazione nei risultati post-elaborazione [IN-24980]

Selezione di spigoli aggiuntivi in seguito alla modifica del fillet dello spigolo [IN-27932]

Comparsa di spigoli nascosti in numerosi strumenti [IN-32396]

Possibilita di selezionare ancora alcuni snap "nascosti” con Snap a visibile [IN-33450]

Visualizzazione errata di ViewCube quando si usa la scheda grafica AMD [IN-32550]

Nessun effetto sulla visualizzazione quando si assegna un materiale e si abilita Rendering rapido nella scheda Stampa 3D
[INP-2092]

Quando le unita del modello sono impostate su MMKS, i risultati di Autoanalisi sono graficamente errati. Tuttavia, i risultati
numerici di Modo sono corretti. Per il momento, gli utenti possono eseguire un'autoanalisi usando le unita del modello MKS (in
Preferenze). E anche possibile usare le unita del modello MMKS e quindi aprire il file .H3D risultante in HyperView. [IM-4658]
| flag Min/Max e i flag Nota all'interno del contesto di revisione risultati del corpo flessibile non vengono visualizzati quando si
usano le unita del modello MMKS (in Preferenze). [IM-4952]

| risultati dell'uscita di potenza non vengono scalati correttamente quando si usano le unita del modello MKS (in Preferenze).
Per il momento si consiglia di usare le unita del modello MMKS quando si cercano risultati dell'uscita di potenza per motori e
attuatori. [IM-4916]

Quando si caricano i risultati di Analizza parte da versioni precedenti, il tempo di caricamento dei risultati potrebbe aumentare.
Verra visualizzato un messaggio di avviso che include I'opzione per procedere con il caricamento o annullare I'operazione, nel
caso in cui potrebbe risultare piu rapido eseguire un nuovo comando Movimento + Analizza parte. [IM-4940]
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Altre informazioni su Inspire

E possibile ottenere altre informazioni sulle funzionalita nuove ed esistenti di Inspire utilizzando le risorse seguenti:

Assistenza utenti nell'applicazione
Inspire fornisce due tipi di assistenza utenti. Le descrizioni dei comandi migliorate vengono visualizzate passando il puntatore su
icone e altre funzionalita. Queste descrivono I'operazione svolta dallo strumento.

U bl

Mirrc
Patch

Fill in missing surfaces, or remove and
remake problematic surfaces.

43 Press F1 for more help.

La guida al flusso di lavoro viene visualizzata quando si seleziona uno strumento che apre una barra guida o una microfinestra di
dialogo. Il testo informa I'utente sull'operazione successiva da svolgere.

= Find «— —= [ » Partition All

Click a selected feature to partition it. =X ¥

b =

Fare clic su per visualizzare suggerimenti e tasti di scelta rapida. Alcuni strumenti includono anche un video

= Find “— —= [ » Partition All

Click a selected feature to partitionit =M =

Holes and pockets are automatically selected
and shown in red, but you can manually select
faces as well.

s Partition a selected feature.
Ctr+@  Addfremove from selection.
Del Remove a partition.

F1 Show Help
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Guida offline e online
Premere F1 o selezionare File > Guida > Guida per accedere alla guida in linea.

Altair Inspire™

] -~
' g4 o o8 ‘ _/“‘
What's New Get Started Tutorials
Discover new features and New to Inspire? Learn the basics Start using Inspire with our
enhancements. here. interactive tutorials.

Per scaricare una versione offline, selezionare File > Guida > Scarica Guida offline. Per il download é richiesta la connessione a
Internet.

D New Help Options
] open.. Help ..
Open the help for Inspire
Open Recent > =
Download Offline Help
Import... Download and install offline help for Inspire
Tutonals...
C Download and install offine help for Inspire |
POM ¥ | What's New___
Read aboutthe latest enhancements
- About Inspire
Save As... Display importantinformation about Inspire
Contact Support

Contact Altair support
Screen Capture  »

Help >
Licensing

Preferences ... Exit

Lingue supportate

La lingua dell'interfaccia utente e della guida in linea pud essere modificata in Preferenze in Spazio di lavoro > Lingua. |l testo
dell'interfaccia utente & disponibile in inglese, cinese, francese, tedesco, italiano, giapponese, coreano, portoghese e spagnolo.

La guida in linea e offline € disponibile in inglese al momento del rilascio e in cinese, giapponese e coreano generalmente da 1 a 2
mesi dopo il rilascio. Se nelle Preferenze viene selezionata una lingua supportata per il testo dell'interfaccia utente ma non per la guida,
viene visualizzata la guida in inglese. Allo stesso modo, se nella finestra di dialogo Scarica Guida offline viene selezionata una lingua
non supportata, verra invece scaricata la guida offline in inglese.
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